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Typing Math 
 

The purpose of this assignment is to learn how to produce word-processed documents containing 

mathematical expressions and graphs that look like they could have come from a textbook. The 

introductory information is to show the difference between how math expressions look when typed by 

an amateur and when typed by a connoisseur of the mathematical typewritten word. In the next section, 

you’ll find brief instructions on how to use MathType to produce professional-quality results (some 

professionals actually use this program). That’s followed by a primer on producing good graphs with 

Winplot. Finally, you will find an assignment to complete using those skills. 

 

Introduction: How “good math” looks on the page. 
In the table below you will find several examples of incorrectly and correctly typeset mathematical 

expressions. 

Incorrect Correct Comments  

y = -(x-2)^4 + 1 y = –(x – 2)
4
 + 1 

Three things here. The obvious one is that the exponent should be 

typed as a superscript rather than with a caret (^). The other two are 

more subtle. Variables should be italicized, in general, as should the 

names of points and constants like e and π. Finally, a minus sign (or 

negative sign, depending on the context) is not just a hyphen, it’s an 

en dash, which is longer. I got the π from the Insert Symbol 

command in MS Word (although it is also the lower-case p in the 

Symbol font) and the en dash by typing control-minus (the minus on 

the number keypad). Important: The MathType program takes care 

of the italics and the longer minus sign for you. You just type, and it 

handles that formatting. 

√(sin x)/(1+x
2
) 

2

sin

1

x

x+
 

Beautiful by comparison, don’t you think? This one I did in 

MathType. It handles the fraction, the radical, and the italics all at 

once. (And slanted fractions are evil.) 

f(|-x|
2
)= f(|x

2
|) ( ) ( )2 2

f x f x− =  

Notice here how MathType lets me have parentheses and vertical 

bars that grow with the expression inside. You don’t get that by just 

typing parentheses and vertical bars. You choose them from menus 

(or with keyboard commands). Also, notice that function names are 

italicized, but parentheses and numbers are not. MathType does that 

automatically, but if you are typing “regular” text, you have to do it 

yourself. 

   {x, if x >=0 

|x| = {-x, if x < 0 

, 0

, 0

x x
x

x x

≥
= 

− <
 

The first is a noble but ill-fated attempt to type the definition of 

absolute value as a piecewise function. The second is how it ought to 

look. It uses a 2x2 grid to organize the parts of the piecewise 

function; this is found in the  menu. The correct version also 

has a left brace that will grow to whatever height is needed, 

automatically, from the  menu. By the way, while ≥ can be 

found in a menu, > and < are just keys on the keyboard! 

y
2
 = 4 => y = +/-2 y

2
 = 4 ⇒ y = ±2 

The “implies” arrow comes from the Symbol font, and I got it from 

the Insert Symbol command in Word. The ± character is in all 

ordinary fonts (Alt-0177), but I also located it in the same dialog. (If 

you have a Mac instead, it’s just shift-option-+) Incidentally, I type 

the italics and superscript on the fly, rather than going into 

MathType, because it’s faster for me. If you feel more comfortable 

doing all of the formulas in the separate program, that’s fine, too. 

But beware! You will have a much simpler time doing this if you 

type text as text in your word processor, and then choose Insert 

Equation whenever you need to use something from MathType. Just 

keeping MathType open and copying and pasting from there seems 

to cause crashing problems. I don’t know why, but the program just 

behaves much better when used in the insert mode. 
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2.3 x 10
-5

 2.3 × 10
–5 

The × is from the Symbol font, and I used a correct negative sign. 

Use of x italicized for times not only looks funny, it’s just plain 

wrong. 

h(x) = 2x
2
/(x

2
 – 9) 

2

2

2
( )

9

x
h x

x
=

−
 

This one wasn’t completely wrong to begin with, just not easy to 

read. Avoid the use of slanted fractions when there is more than one 

term in either the numerator or denominator. They require very 

careful use of parentheses, and even then can be hard to follow. (If 

you have trouble remembering this advice, you can simplify it to the 

mantra, “Slanted fractions are evil. Slanted fractions are eeeeevil.” 

lim [(sin x)/x] 

x->0 0

sin
lim
x

x

x→
 

Again, a decent attempt, but look how it ought to be. MathType has 

a command in the  menu that lets you put the x → 0 part right 

under the limit. And the fraction doesn’t require lots of grouping to 

look right. 

 

MathType: Using the program 
First of all, MathType is a commercial program, but you can download a free 30-day evaluation copy. If, 

after 30 days, you don’t pay for it, it reverts to a program called MathType Lite, which is the version I’m 

actually using to type this document. Clearly, the Lite version will do everything you need, and it’s free. 

The URL is http://www.mathtype.com/. From the main page, choose MathType and then Download a 

30-day trial. You can choose either Windows or Macintosh. Note that providing your e-mail address is 

strictly optional. It will download just fine without that information. 

 

When you install MathType and have Microsoft Word on your computer, you automatically get buttons 

on a toolbar for inserting equations. It’s a blue Σ sign. After it reverts to the free version, you may lose 

that, but it’s easy to make a “watch-me” type macro to do the same thing. Without a button to click, or if 

you’re using some other word processor, after you’ve installed the program, you go to the Insert menu 

or tab and choose Object, then MathType equation. As far as “non-Word” word processors, those will 

also generally behave well with MathType. I know that people always seem to have problems getting 

the inserted formulas to align correctly in Microsoft Works, so you’re probably best off avoiding that. If 

that’s your primary word processor, I’d suggest downloading OpenOffice (http://openoffice.org-

suite.com/index.asp, again, completely free) to use on your home computer when you need the 

functionality of MathType. It actually comes with a Math program that can be used to do what 

MathType does, but I’ve never used that part myself. Mainly I use OO to open just about any word-

processing file type that I run across (especially WordPerfect, which I can’t get to open with Word or 

really anything else). 

 

When you insert an equation, you’re presented with a window more or less like this. 

 

http://openoffice.org-suite.com/index.asp
http://www.mathtype.com/
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You type in the white area. The buttons at the top are all drop-down menus of various symbols (on the 

top) and templates (on the second row). The names don’t matter so much, but the difference is that the 

boxes on the second row provide places for you to input more expressions. The symbols on the buttons 

give you some idea of the types of things you will find in the menu. In general, when you need one of 

the things on the second row, like a fraction or a vector, you should choose the template first, then type 

the numbers or letters. In the full version, some commonly used things are more readily accessible, and 

you can click on those, too. At the end of the MathType section of this document, you will find a set of 

screen shots of those menus that may help you find things more easily at first. 

 

For the most part, the program works exactly like you would expect it to. For instance, if you choose a 

fraction template from the second row, you first type in the numerator, then either click in or tab to the 

denominator. The tab key will move you through the various parts of an expression easily. To update the 

equation in your document and close the window all at once, use Control-F4. 

 

A couple of things to know: Sometimes, the program will treat an expression like a variable when you 

know it shouldn’t. For instance, entering this integral normally gives cscarc xdx∫ . (Don’t worry now 

about what it means. What you need to know is that the part after the squiggly sign should look like 

“arccsc x dx” — with no italics on the first part, and a space between x and dx. To fix that, select the 

“arc” part, and choose Text from the Style menu. That will remove the automatic italics. You can insert 

a space not, as you would expect, by just typing the space key (fooled you!), but by typing Control-

Space (I used two to get the separation I wanted). If you just try a space in Math style, the program will 

beep at you, indicating that it thinks it’s smarter than you are in matters of mathematical typesetting. 

And to be fair, that’s generally true. Here’s how the integral should look: arccsc x dx∫ . 

 

Secondly, there’s another oddity about integrals (a calculus thing, for those of you who still haven’t 

figured out when you’re going to run into them). Compare these two expressions: 
2

21

3

3

x
dx

x− +∫  and 
2

2
1

3

3

x
dx

x− +

⌠
⌡

. 

See how much better the second one looks? For reasons known only to Design Science, its publisher, 

MathType doesn’t automatically use an expanding integral sign, while parentheses, brackets, and so on, 

all adjust size automatically. To get the second one, hold down the Shift key while clicking on the menu 

and selecting the integral (the one with little black rectangles where you see the numbers in mine). That 

makes it adjust to fit what you type. 

 

MathType’s symbol and template menus, with some comments: 

 Note that ≺ and � 

are not > and <. The 

latter pair is on the 

keyboard. Of the 

computer. 
 

 Some of the 

things on this 

menu are not 

available in Lite 

mode. You can 

tell when the 

cursor changes 

as you hover 

over them. I 

never use those. 
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 This is where the 

multiplication 

symbols are found. 

For a multiplication 

dot, you want the 

smallest of the three 

available. The open circle you 

see here is not the degree sign. 

That’s a couple of menus down. 

 This is where 

to find the 

implication 

arrow (⇒) and 

function 

mapping 

symbol (↦).  

 This is the menu 

with the degree 

sign and the 

triangle symbol 

from geometry. 

 Lowercase theta 

(θ), alpha (α), beta 

(β), and sigma (σ) 

are all here. 

 

This is where 

you’ll find 

parentheses, 

brackets, and 

absolute value 

signs that 

expand to hold 

what you type, 

as well as one-

sided versions of 

those. 

The first one is a 

regular fraction and 

the second is a smaller 

fraction. Remember 

that slanted fractions 

are evil, and don’t use 

them. Also, you have 

the square root sign as 

well as a template that lets you 

put in a different index to tell 

which root. 

The very first one is 

for superscripts. The 

one that you want 

for the limit I typed 

in my examples is 

in the middle of the 

third row. The ones 

with bigger boxes 

make the text in them bigger, 

too. 

The little black 

boxes are places you 

can type additional 

small text. 

Remember that to 

get one of the 

integral (curvy S) 

signs that expands 

with what you type, 

you have to hold 

down the shift key 

while selecting from 

this menu. 

The half-arrow 

you want to put 

on a single 

character is in the 

first row, not 

here. These are 

used to put more 

than one 

character in a box. 
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These are good for 

matrices, but equally 

excellent for 

aligning things 

evenly, as in the 

piecewise function 

example. 

 

 

 

Winplot: Making pretty function graphs 
Winplot is a free program written by Richard Parris, a math teacher at the prestigious Philips Exeter 

Academy in Exeter, New Hampshire. Either Exeter pays a lot better than your average high school, or 

Mr. Parris is a philanthropist, because he has an entire suite of free math programs that you can 

download and use at your leisure. All of Peanut Software (his imprint) is available at 

http://math.exeter.edu/rparris/; the link for Winplot itself is http://math.exeter.edu/rparris/winplot.html. 

You’ll want to click on the very first word on that page to download the current version of the program. 

The version on the lab computers is not the most recent, but Parris constantly updates it on his site. As I 

type this, the most recent version is four days old. 

 

When you first start up Winplot, you’re presented with an unimpressive 

little window. Don’t be fooled. From the Window menu, choose 2-dim. 

This will open up a grid. Then in that window, from the “Equa” menu, 

choose Explicit. Here’s where you can enter your expression to be 

graphed. You enter expressions basically like you would in a calculator, 

with * for times, / for division, and ^ for powers. Use parentheses 

carefully, just like you have to on a calculator. In this window you can adjust the initial domain and the 

color of the curve, but there’s a lot more you can do from other locations. For instance, you can set 

whether or not the grid shows, how often numbers are put on the 

axes and how they look, whether the axes should be given in terms 

of pi, and lots of other things. When you hit OK, you’ll get the initial 

graph as well as a window in which you can change settings and add 

other graphs to the same axes. You’ll probably want to experiment 

with some of these things. In particular, clicking on the “Equa” 

button in the Show portion of the box will show or hide the 

expression graphed, but it will look the same way it did when you 

typed it, not like it would if you used MathType. That’s a good thing 

to remember when handing in work…. 

 

 

The most important things to know about getting a graph to look like you want are how to use the View 

command and how to set up the Grid. Both of these are found in the View menu of the graph itself. 

http://math.exeter.edu/rparris/winplot.html
http://math.exeter.edu/rparris/
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First, the View. Initially, you’ll probably find the 

radio button for “set center” turned on, which is 

different than what you’re used to on a graphing 

calculator. To set the window like you would on 

your calculator, be sure to click in the radio 

button for “set corners” in addition to typing in 

the Xmin, Xmax, Ymin, and Ymax values in the 

appropriate boxes. 

 

Then the Grid. What you see here is pretty 

standard. You probably want 0 in the Places 

boxes, since you don’t generally need decimal 

places in axis labels (1.0, 2.0, etc.). Interval 

indicates how often the grid lines should be drawn, and Freq indicates how often they should have 

numbers by them. You can experiment by changing settings and using the apply button without actually 

closing the dialog. If you’re graphing something trigonometric and you want axis labels in terms of pi, 

you have to do two things. First, you’ll check the “pi” box on the x-axis. You’ll also enter an interval for 

x in terms of pi. A common setting is “pi/2,” typed that way. 

There are a tremendous number of graph types that this program can handle. Of particular use to you 

might be the ability to have points and vertical lines plotted. They are both available from the Equa 

menu. Try them out yourself. The Line command will plot any line, but is particularly useful for vertical 

ones, since you can’t solve them for y and use the standard Explicit command. To add a second curve to 

the same graph as the first, just choose the appropriate type from the Equa menu of the current graph. If 

you want a new graph entirely, you can save the current one (or not), and choose New from the File 

menu. If you don’t choose to save it and you need to change it later, you have to start from scratch. 

MathType equations, on the other hand, can be double-clicked to edit later. 

Getting the graphs into a word processing document is simple. With the graph displayed as you like it on 

screen, choose Copy to Clipboard from the File menu. It seems to work best to make the window on 

screen more or less the size you’re going to want it in your document before copying. (On the lab 

computers, it may help to make the font size of the numbers on the axes bigger, too.) Then go to your 

word processing document and paste. There it is. You can resize it by dragging a corner. That’s 

generally a good idea, because full-page computer-generated graphs are rarely worth that much space. 

You can type around the graph, as I have done with the pictures in this document, by right-clicking on 

the picture, and choosing Tight, Square, or something else from the Text Wrapping menu (this is in 

Word, mind you). Then you can drag the graph wherever you’d like it to be. 

For printing purposes, a white background is advisable. If that’s not what you currently see, it can be set 

from the Misc, Colors, Background menu. Remember, if a graph hard to understand, it won’t help your 

communication, no matter how cool it may look to you. Also, the computer is just a bigger and more 

colorful version of your graphing calculator, and the software is subject to some of the same limitations, 

like not always showing holes and connecting dots it shouldn’t. You can restrict a function to a limited 

domain when entering it (or editing it) by choosing Lock Interval along with the minimum and 

maximum x-values you need. That allows you to get correct piecewise functions. 
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The Assignment 
Your assignment is to reproduce the things you see here, yourself. You may choose whatever colors you 

like on the graphs as long as they remain readable. Your goal is to have your work look as much like 

mine as possible, although you don’t have to type the comments I typed in parentheses and you don’t 

have to use two columns. The assignment counts 50 points. 

 

Begin by opening a new Microsoft Word document and typing the number of the first problem and the 

words that follow. Then insert an equation. In general, it is not a good idea to do more than one equation 

at a time in MathType. So insert the equation, close the MathType window, and go on to the next one. 

Important: only save your work to the folder on the lab computer that’s explicitly for student work or to 

your own removable device. If you save it anywhere else on the lab computer, your work will be lost 

when the computer is next shut down. Save early and often. You’ve been warned. 

 

You will submit your work to me electronically. You can do this by e-mailing me the finished document 

from your own web mail or by asking me to let you save it to my flash drive in the lab. 

 

Geometry: 
 

1. Congruent segments 

 AB BC≅  
 

2. Similar triangles 

 JOE TED∆ ∆∼  
 (On my screen that looks like a minus 

sign, but it’s really a “similar” tilde.) 
 

3. Angle measure 

 82m A∠ = °  
 

4. Perpendicularity 

 PQ EF⊥
���� ����

 
 (Look closely at the arrows. The first is a 

double arrow for a line, and the second is a 

single arrow for a ray.) 

 

Algebra: 
 

5. Piecewise-defined function 

 
2

3 , 1
( )

2 5, 1

x x
f x

x x

 < −
= 

− ≥ −
 

 

6. Rational expression 

 
3 22 7

( 5)(2 9)

x x

x x

+ −

− +
 

 

7. Radical expression 

 315 35⋅  
 

8. Complex fraction 

 

2
1

5
3

7
2

x

x

+
−

−
+

 

 

9. Quadratic formula 

 If ax
2
 + bx + c = 0, then

2 4

2

b b ac
x

a

− ± −
= . 

 

10. Binomial theorem 

 ( )
0

n
n n r r

r

n
a b a b

r

−

=

 
+ =  

 
∑ , , ; ,a b n r∈ ∈� �  

Vectors: 

11. Named with endpoints 

 AB BC AC+ =
���� ���� ����

 
 (Those are right-pointing arrows on top.) 
 

12. Using unit vectors 

 
2

2 3
3

− 
= − + 

 
i j  

 (There’s a vector style for the bold) 
 

13. Formula for the angle between vectors 

 cosθ
⋅

=
u v

u v
 

 

Probability and Statistics: 
 

14. Probability of occurrence of either of two 

events 

 ( ) ( ) ( ) ( )p A B p A p B p A B∪ = + − ∩  
 

15. Conditional probability 

 ( )
( )

( )
|

p A B
p A B

p B

∩
=  
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16. Formula for standard deviation 

 

( )
2

1

k

i i

i

f x x

n
σ =

−

=
∑

, where 
1

k

i

i

n f
=

=∑ . 

 (Be careful where the subscripts and 

superscripts show up.) 

 

Trigonometry: 
 

17. Pythagorean identity 

 2 2sin cos 1θ θ+ =  
 

18. Sum and difference identity 

 ( )cos cos cos sin sinα β α β α β± = ∓  

 (yes, that’s a minus-or-plus, rather than a 

plus-or-minus, on the right-hand side.)  

 

Calculus: 
 

19. Limit 

 
1

lim 0
x x→∞

=  

 

20. Derivative 

 [ ] 2tan sec
d

x x
dx

=  

 

21. Integral 

 
1

1
ln , 0

x

x dt x
t

= >⌠
⌡  

 (That’s lowercase LN, the natural 

logarithm.)
 

 

Graphing: 

22. y = x
2
 – 2x – 3 and y = 

1
1

2
x− +  

  
 

23. y = cos x and y = sec x 

 (You enter these with parentheses around 

the x, just like on your calculator.) 
 

  
  

24. 22 5y x= −
 

 (You type the absolute value into the 

graphing program as abs, just like the 

calculator command.)
 

   
 

25. 225y x= −  

 (It’s a semicircle, and should look like 

one.) 

  
 

 

Once you have finished this and turned it in, go 

to the precalculus page of my web site, and 

work through the Graphing in Excel tutorial. 

You do not have to turn in the graph you make, 

but you should be able to follow all the steps. 

This is another skill that you will need down the 

road. 
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